@ UNIVERSITY OF ENME 489Y Assignment #8

ENME 489Y — Remote Sensing: Spring 2018
Department of Mechanical Engineering

Due Date Friday, April 27*", 2018
Submission e Compile links to each YouTube video into a single .pdf file and upload the
Information .pdf to Gradescope by 11:59pm

Mesh of lidar point cloud data & (optional) 3D print

General Reminder: continue recording pictures & videos of your project to edit/stitch together in your
semester project video (due 5:00pm May 17'") and final project presentation (beginning May 1!

Please!...record videos with your cell phone, GoPro, etc. horizontal. Vertical videos are dangerous!

In Assignment #5 we integrated, aligned, and calibrated our field deployable lidar systems. In
Assignment #6 we recorded a preliminary dataset in a controlled environment to ensure our lidar
systems were functioning as intended, then headed out on campus to begin mapping our targets. In
Assignment #7 we mapped each side of our targets and combined the processed [x, y, z] data into a
single 3D point cloud.

In this assignment (...the last assignment of the semester!) we create a solid mesh file from the
completed 3D point cloud then, as an option for extra credit, 3D print the file.

From the cockpit:

Dr. Mitchell and Will understand that everyone in 489Y is juggling 1x10° different activities at this point
in the semester. In an attempt to reduce some of the pressure, we have:

1. Modified the schedule for Final Project Presentations. Since Design Day for those students in
ENME472 occurs on Tuesday May 8™, we will hold neither lecture nor presentations on May 8.
In other words — there is no need to attend 489Y on Tuesday May 8. Use this time to continue
working on your Final Project Video.

2. Moved the deadline for submission of Final Project Videos from Tuesday 5/15 back to
Thursday 5/17. Videos are due via email submission to Dr. Mitchell (mitchels@umd.edu) by
5pm EST on Thursday May 17%. Please cc Will (wbogdan@terpmail.umd.edu) on your
submission as well. Include in the email:

a. Alink to your YouTube video

b. An attachment as a single .ppt file (or provide a link for download) which will be the
final, polished copy of your Final Project Presentation. Name your .ppt file
lastname_firstname_ENME489Y.ppt
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@ UNIVERSITY OF ENME 489Y Assignment #8

Question #1 (nothing to submit)

Final Project Presentations will be held in the lecture hall on May 1%, 3, and 10™. To be fair and

supportive to the entire class, each student is required to attend each lecture (even if you are not
presenting that day).

To account for the lost day on May 8™ (see previous page), Final Project Presentations will begin
promptly at 915am each day. Please arrive at the lecture hall no later than 910am each day such that
we can begin presentations right away.

For details on presentation requirements, order, and submission, refer to ELMS > Modules > Project:

i v Project ©
ENME 489Y - Spring 2018 - Project Requirements v1.pdf

Lidar mount & solid model files

Rubric: Final Project Videos

Final Project Presentations: May 1, 3, & 10

Importing a Mesh into CREO

© 0 0 o ©

Question #2 (nothing to submit)

Final Project Videos are due Thursday 5/17 via email submission to Dr. Mitchell (mitchels@umd.edu) by
5pm EST. Please cc Will (wbogdan@terpmail.umd.edu) on your submission as well.

Include in the email:
a. Alinkto your YouTube video
b. An attachment as a single .ppt file (or provide a link for download) which will be the
final, polished copy of your Final Project Presentation. Name your .ppt file
lastname_firstname_ENME489Y.ppt

Note: although homework submissions this semester have been graded primarily for completeness,

Final Project Videos will be subject to the full scrutiny detailed in the grading rubric detailed on ELMS >
Modules > Project.

The Final Project Video represents an entire semester’s worth of learning and activities and will be
graded as such - so please ensure you present your best work in the submitted YouTube video!
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i v Project ©
ENME 489Y - Spring 2018 - Project Requirements v1.pdf

Lidar mount & solid model files

Rubric: Final Project Videos

Final Project Presentations: May 1, 3, & 10

Importing a Mesh into CREO

© 0 0 o ©

To view exemplary Final Project Videos from previous semesters, scroll through the 489Y YouTube
playlist:

https://www.youtube.com/watch?v=11i44{PISbw&list=PLekqOMAzgrTRP6Ms7wI37-2IKju92tgnL

Question #3 (optional submission)

As discussed by Eugenia de Marco in her lecture, Murphy’s Law is ever-present in the field of remote
sensing. Here are examples of instances where things did not go as planned, just this semester:

“Hi Dr. Mitchell,
I apologize for emailing you so late, but | wanted to let you know that while | was taking

data tonight | accidentally knocked over my mount and broke the ribbon cable connecting my camera to
my raspberry Pi.”

“Hi Dr. Mitchell,
Everything was working well in my house while | was connected
to wifi but the minute | stepped outside, everything stopped working.”

“Hey Dr. M,

Got some terrible news. | was collecting data and had to raise the
tripod to a greater height to get data. But the wind was really strong and
when | wasn’t paying attention, it tipped over and broke the 3d printed
holder in half. But the even more terrible news is the Rpi camera is not
working anymore.”

Although frustrating, these types of events do occur...and will occur often in the “real world” after
graduation. The key, as Eugenia pointed out, is to budget time (and money) up front such that if
something goes wrong you have time to recover and meet the deadline(s). (customers are demanding!)

With that in mind, if Assignment #7 did not turn out as well as you would have preferred, consider
heading back out on campus to remap your target. Record a minimum 60 second video clip of yourself
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demonstrating the process of translating .jpg image files into a 3D point cloud, in particular how you
stitched together all of the scans, recorded via your laptop. Be sure to highlight any interesting
qualities of the 3D point cloud. Upload the video to your YouTube account, then insert the link in a .pdf
file to be uploaded to Gradescope.

Dr. Mitchell will review your updated videos and offer feedback as desired, such that the final point
cloud presented in your Final Project Video is polished and ready for display.

Question #4 (20 points)

As Dr. Resop discussed in his lecture, there exists a variety of software packages that can convert a 3D
point cloud into surface and solid model files. Meshlab is one such open-source platform, which we
utilize here in 489Y.

To complete Question #4, you will need all of your point cloud data in a single .txt file. If you
opened/combined multiple .txt files in MATLAB to plot your cloud in Assignment #7, save those as a
single .txt file listing all [x, y, z] coordinates for this exercise. One approach to creating such a .txt file is
to use the fprintf( ) command in MATLAB:

fileID =
fopen ("\\client\CS\Users\Steve\Desktop\Path to file here\NAMEOFFILE.txt',6 'w')

fprintf (fileID, '$f $f $f\r\n',B);
fclose (filelID);

Head to http://www.meshlab.net/ and download the latest version of MeshLab onto your laptop.

€ C | ® www.meshlab.net/#download sls@ 0

the open source system for processing and editing 3D triangular meshes.
M es h La b It provides a set of tools for editing, cleaning, healing, inspecting,

rendering, texturing and converting meshes. It offers features for
processing raw data produced by 3D digitization tools/devices and for preparing models for 3D printing.

Input the .txt file containing all of the [x, y, z] coordinates that define the complete 3D point cloud into
MeshLab.

Page 4 of 15



@ UNIVERSITY OF ENME 489Y Assignment #8

For additional details on the use of Meshlab, please refer to the Appendix of this assignment (credit:
Katie Jahn & Will Bogdan, UMD ’18).

Record a minimum 120 second video clip of yourself demonstrating the process of translating a 3D
point cloud .txt file into a mesh file in Meshlab. Be sure to highlight any interesting qualities of the
surface mesh as compared to the 3D point cloud. Upload the video to your YouTube account, then
insert the link in a .pdf file to be uploaded to Gradescope.

Question #5 (optional submission)
As detailed in the Project Requirements, students may 3D print a solid model of their target, to be

delivered to Dr. Mitchell for a maximum of 5 pts extra credit. A brief writeup on how to import Meshlab
files into CREO has been provided by Jason Musick (UMD ’17) and is available on ELMS:

i« Project °
ENME 489Y - Spring 2018 - Project Requirements v1.pdf

Lidar mount & solid model files

Rubric: Final Project Videos

Final Project Presentations: May 1, 3, & 10

© 0 0 0o ©

Importing a Mesh into CREO

Jason also discusses the point cloud to mesh file to solid model file processing here (7:00 minute mark):
https://www.youtube.com/watch?v=UDsq_CgguYQ&index=2&list=PLekqOMAzgrTRP6Ms7wI37-2IKju92tgnL
Record a minimum 60 second video clip of yourself demonstrating the process of translating a mesh file
into a solid model file in CREO, SolidWorks, etc. Upload the video to your YouTube account, then insert

the link in a .pdf file to be uploaded to Gradescope.

Once completed, 3D prints can be delivered at your convenience to the ME front office anytime prior
to 5pm EST on Thursday, May 17t". Simply ask the staff to place the print in my mailbox.

Finally, to complete Assignment #8:

Upload a single page .pdf to Gradescope with the links to each YouTube video recorded within this

assignment. Label each link such that Dr. Mitchell understands which videos correspond to which
questions.
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Creating a Mesh in MeshLab

Import points:

1. Start new project
2. Press open folder icon (Import Mesh)
3. Select text file containing points
4. Select separator used between data points in text file (SPACE)
& Meshlab 2016.12 - [Project_2] - (] x

@ File Edit Filters Render View Windows Tools Help

DF o8 . B g SO - T e /MU TRAUEAD X XX

P

Point format
Separator
Color format

On Parsing Error

Reset

5. Hit ok

© MeshLab_64bit v1.3.4BETA - [Project_2]
@ File Edit Filters Render Vi

indows Tools Help

Or@@e aedn @M

& BERR S EED XXX

NEE
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ENME 489Y Assignment #8
Mitchell, Spring 2018

6. Adjust the Point Size trackbar (lower righthand side of screen) to increase/decrease diameters
of points.
7. At this point, the point could in MeshLab should look like the point cloud in MATLAB.

Compute Normal for Points:

1. Render -> Show Normal

© MeshLab_64bit v1.3.4BETA - [Project_2]
% File Edit Filters Render View Windows Tools Help

D @ E\Z § Render Mode

Lighting
Color

Shaders

Background Grid

Show Vertex Dots

Show Non-Faux Edges

Show Boundary Edges

Show Non Manif Edges

Show Non Manif Vertices

Show Normal/Curvature

Show Quality Histogram

Show Quality Contour

Show Box Corners

Show Axis

Show Quoted Box

Show Label

Show Camera

Show UV Tex Param

Show Current Mesh

Show Texture Seams
Rasters-to-geometry reprojection
Enable shadow mapping

Enable Screen Space Ambient Occlusion

| e CH® ¢ BiEE I EE O XXX

Draw per vertex/face normals and per vertex principal curvature directions

2. Filters -> Normals, Curvatures and Orientation -> Compute normals for point sets

& MeshLab_64bit v1.3.4BETA - [Project_2]
% File Edit Filters Render View Windows Tools Help

D&

Apply filter Ctrl+p

Show current filter script
Selection

Cleaning and Repairing

Create New Mesh Layer

Remeshing, Simplification and Reconstruction
Polygonal and Quad Mesh

Color Creation and Processing

Smoothing, Fairing and Deformation

Quality Measure and Computations

Normals, Curvatures and Orientation

Mesh Layer

Raster Layer

Range Map

Point Set

sampling

Texture

Camera

¥ JullSlc Ty

Compute Face Normals
Compute Per-Polygon Face Normals

Compute Vertex Normals

Compute curvature principal directions

Compute normals for point sets

Cut mesh along crease edges Compute the normals of the vertices of a
Discrete Curvatures mesh without exploiting the triangle
connectivity, useful for dataset with no
faces

Freeze Current Matrix
Invert Faces Orientation
Normalize Face Normals
Normalize Vertex Normals (flter.meshing dIU
Per Vertex Normal Function

Re Orient all faces coherentely
Reset Current Matrix

Smooths normals on a point sets
Transform: Align to Principal Axis

Transform: Flip and/or swap axis

Transform: Move, Translate, Center
Transform: Rotate

Transform: Rotate to Fit to a plane
Transform: Scale

B i EE8@ XXX
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3. Hitapply

DEpceBss TEBAII IR cOHS e - WATh: S ERD XXX

Compute normals for point sets

Compute the normals of the vertices of a mesh without exploiting the
triangle connectivity, useful for dataset with no faces

Neighbour num (10
Smooth Iteration 0

[ Flip normals w.rt. viewpoint

Viewpoint Pos. u‘ a‘ ‘ Get |View Dir

Default Help

Close Apply

Filter successfully completed...

4. The default value will most likely not work, since the goal is to get all the arrows facing the same
direction
a. Try not to smoothen (keep the second box as 0)
b. Higher neighbor num usually yields better results, try not to get too high (stay just
above where the arrows are pointed towards the same direction)
c. Ifyou know where the lidar was in relation to the points, you can input that into the
viewpoint position which may help
d. Keep hitting apply and changing numbers until you get the desired result: all arrows
pointed in the same direction (it will overwrite the last result)

© MeshLab_64bit

NFPConES 5 ISP G OHB - - BARE L EED XX

Compute normals for point sets

Compute the normals of the vertices of a mesh without exploiting the
triangle connectivity, useful for dataset with no faces

Neighbour num 33

. viewpoint
Viewpoint Pos. 0 o o Get [View Dir

Default Help

Close Apply.
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Apply Mesh:

1.

OF ENME 489Y Assignment #8

Mitchell, Spring 2018

Go to Filters -> Remeshing, Simplification and Reconstruction -> Screened Poisson Surface

Reconstruction

& MeshLab_64bit v1.3.4BETA - [Project_2]
< File Edit Filters Render View Windows Tools Help

D @ Apply filter Compute normals for point sets ~ Ctrl+P
Show current filter script
Selection >
Cleaning and Repairing >
Create New Mesh Layer >
T —— . y
Polygonal and Quad Mesh ’
Color Creation and Processing >
Smoothing, Fairing and Deformation >
Quality Measure and Computations >
Normals, Curvatures and Orientation >
Mesh Layer >
Raster Layer »
Range Map >
Point Set »
sampling >

Texture
Camera

Surface Reconstruction: Poisson

Use the points and normal to build a surface
using the Poisson Surface reconstruction
approach.

Octree Depth |
Solver Divide 6
Samples per Node 1
Surface offsetting 1
Default

Close

5 ~ el o
Alpha Complex/Shape
CSG Operation

Close Holes

7R E RO XXX

Clustering decimation
Convex Hull

Crease Marking with NonFaux Edges
Curvature flipping optimization

Cut mesh along crease edges

Delaunay Triangulation

Iso Parametrization

Iso Parametrization Build Atlased Mesh

Iso Parametrization Load Abstract Domain
Iso Parametrization Remeshing

Is0 Parametrization Save Abstract Domain
Is0 Parametrization transfer between meshes
Marching Cubes (APSS)

Marching Cubes (RIMLS)

Mesh aging and chipping simulation

Planar flipping optimization

Points Cloud Movement

Quadric Edge Collapse Decimation

Quadric Edge Collapse Decimation (with texture)
Refine User-Defined

Simplfication: MC Edge Collapse
Subdivision Surfaces: Butterfly Subdivision
Subdivision Surfaces: Catmull-Clark
Subdivision Surfaces: LS3 Loop
Subdivision Surfaces: Loop
Subdivision Surfaces: Midpoint
Surface Reconstruction: Ball Pivoting
Surface Reconstruction: Poisson
Surface Reconstruction: VCG

Tri to Quad by 4 8 Subdivision

Tri to Quad by smart triangle pairing
Turn into Quad-Dominant mesh

Tum into a Pure-Triangular mesh

Use the points and normal to build a
surface using the Poisson Surface
reconstruction approach.

(filter_poisson.dll)

Uniform Mesh Resampling
Vertex Attribute Seam
Voronoi Filtering

Voronoi Vertex Clustering
Zippering

[P cOH® ¢ - BZIhG L IEED XXX

Page 9 of 15



UNIVERSITY OF

’» MARYLAND

ENME 489Y Assignment #8

Mitchell, Spring 2018

2. Default may work, try this first by hitting Apply. If not then trial and error again

a. Keep surface offset at 1

Surface Reconstruction: Poisson

Use the points and normal to build a surface using the Poisson Surface reconstruction approach.

Octree Depth \6

Solver Divide 6

Samples per Node ‘1

Surface offsetting ‘1

Default

Close

Set the depth of the Octree used for extracting the final
surface. Suggested range 5..10. Higher numbers mean
higher precision in the reconstruction but also higher
processing times. Be patient.

This integer argument specifies the depth at which a block
Gauss-Seidel solver is used to solve the Laplacian

equation. Using this parameter helps reduce the memory
overhead at the cost of a small increase in reconstruction
time. In practice, the authors have found that for
reconstructions of depth 9 or higher a subdivide depth of
7 or 8 can reduce the memory usage. The default value is
8.

This floating point value specifies the minimum number of
sample points that should fall within an octree node as the
octree construction is adapted to sampling density. For
noise-free samples, small values in the range [1.0 - 5.0]
«can be used. For more noisy samples, larger values in the
range [15.0 - 20.0] may be needed to provide a smoother,
noise-reduced, reconstruction. The default value is 1.0.

This floating point value specifies a correction value for the
isosurface threshold that is chosen. Values 1 external
offsetting.Good values are in the range 0.5 .. 2. The
default value is 1.0 (no offsetting).

Help

Apply
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ENME 489Y Assignment #8
Mitchell, Spring 2018

& MeshLab 2016.12 - [Project_2] - [m] x
& File Edit Fiters Render View Windows Tools Help NEIE]
e e = e a e W &2 e e g :
NE#@veomaE= G 011 8 COM - de /MUTEXI®ED XX
Project_2 g X
[ 15 wall* mm
> [ 16 Poisson mesh 7o
wall. bt
@ | % || n w
Shading Vert DotDecorator Naone
Color Mesh | User-Def
Point Size I
apply to al visble layers
» Show Nermal
GUI created in 82 msec A
Adpplied filter Screemed Poisson
airface T fruction G GELE poe
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Delete Additional Faces:

1. Asyou may notice, the Poisson mesh gives additional faces that you need to remove, so click the
select faces in rectangular region on the toolbar (icon with mouse highlighting faces shown
below)

-] MeshlLab_64bit v1.3.4BETA - [Project_2] = X
@ File Edit Filters Render View Windows Tools Help
NEPCYBE & [ ePMm &® -& + B >
Faces in a rectagular region
Project_2 a8 x

> [ 15 wall*

" 16 Poisson mesh

wall. bet
o} noa
Shading Vert DotDecorator None
Color Mesh | User-Def
Point Size I
apply to all visible layers
Show Mormal
GUI created in B2 msesc A
Applied filter Screened Poisson
neface B icw 4 LEG weoer
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2. Highlight the unwanted faces

ENME 489Y Assignment #8
Mitchell, Spring 2018

a. Do not select your points (if this happens, just reselect the faces before proceeding)

b. Don’ttry to get them all at once

c. Rotate your object to a good view before clicking the icon

& MeshLab 2016.12 - [Project 2]
& File Edit Filters Render View Windows Tools Help

NS D @I o

g+~ GOM ¢ ¢

15

58
NDERING

> 16 Poisson mesh (] 7 @ @ 43

- m] X
w || || 20
ReED XX
Project 2 g X
w15 wall® g Bl v | no

Poiseon mesh

] nooQ
Shading Vert DotDecorator None
Color Mesh | User-Def
Point Size I

apply to all visible layers

dpplied filter Screened Poisson
Surface Reconstruction in 3666 msec
Started Mode Select Faces in a
rectagular region

Started Mode Select Faces in &
rectagular regiom

Started Mode Select Faces in &
rectagulsy reaion

A
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3. Click the delete face icon on the toolbar, making sure you click the one with the red x, that
includes both the points and the highlighted face

& MeshLab 2016.12 - [Project 2] - (m] *
@ File Edit Filters Render View Windows Tools Help = &

N w o B

Delete the current set of selected =
fa, nd all the vertices surrounded

by that faces, -
: LR B
(filter_select.dlil) B m m
= Poisson mesh
= - | n nQ
a = Shading Vert DotDecorator Naone
Color Mesh | User-Def
Point Size I
apply to all visible layers
Applied filter Screensd Poisson ~

Surface Reconstruction in 3666 mssc
Started Hode Select Faces in a
rectagular region

Started Mode Select Faces in a
rectagular region

Started Ho Select Faces in &
rectagulay wegion

@ MeshLab 2016.12 - [Project 2] - o X
@ File Edit Filters Render View Windows Tools Help - & %

NERcemES GBIl e Ol SO /BN ERSEED XXX

Project_ 2 & %

15 wall * 8 ne
% 16 Paoissonmesh” [T 20 B (IIER

Poisson mesh

w ;| n o

Shading Vert Dot Decorator  None
Color Mesh | User-Def
Point Size I

apply to all visible layers

Started Mode Select Faces in a A
rectagular region

Started Mode Select Faces in a
rectagular region

Started Mode Select Faces in a
rectagular region

applied filter Delsts Selected Faces
and Vertices dn 191 nsec
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> UNIVERSITY OF
// MARY I AND Mitchell, Spring 2018

4. Repeat until you only have the mesh you are looking for
a. Be careful not to delete your data points

& Meshlab 201612 - [Project_2] - O b4
& File Edit Fitters Render ¥iew Windows Tools Help - &8 X
Newvceomsgs O BN x5 SO/ - T /BETEESEED XX
Praject 2 F X
7 15 wall * 1EA B no

> % 16 Poisson mesh* (7 07 [ A erml

= S ==
— e
= == =
= = s =
= 8
= B
= 8 = P h
= oisson mes
et
- s TE =~ g
= == oL i n Q
= -
=
- ; A Shading Vert DotDecorator Mone
. -
e Color Mesh | User-Def
= =
= =
3=
%
% Point Size I
#

apply to all visible layers

Started Hode Sslect Faces in a
rectagular region

Applied filter Delete Selected Faces
and Vertices in 186 msec

Started Mode Select Faces in a

rectagular region
Applied filter Delete Selected Faces

and Vertices in 200 psec

F 6.7
BO_RENDERING

5. Perform additional processing of the mesh as desired.
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